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Section 1 – Before You Start 
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Introduction: 
 
Thank you for purchasing ��� ������ � , an application designed by NeoTerra ® Systems  for 
the Motorola MOTOTRBO™ Professional Digital Two-Way Radio System, to permit the user 
enhanced control capabilities. The application has been designed to accommodate the safe 
tracking of fleet and similar fixed locations that use the MOTOTRBO product. The application 
has an archiving reporting feature that reports on activity captured by various parts of the 
application. 
 
NeoTerra ® Systems  has worked with the end users to streamline the application and make it 
simple to install, easy to use and understand. 

Before Installing the Software: 
 
It is IMPORTANT to ensure that prior to configuring ��� ������ � ; that your Computer route 
table has been appropriately updated; so that the MOTOTRBO™ radio network can be 
accessed (Windows XP and Windows 7 PC’s only).  Please refer to the “Network Configuration” 
portion of this guide. 
 
��� ������  will require a USB “Key” to work with and validate the licensing agreement. This 
“Secure Key” will be supplied once the purchase has been approved. 
 
Important Note:  Before installing ANY NeoTerra Sof tware, be sure to DISABLE User 
Account Control if running Windows Vista or Windows  7 operating systems on the 
server.  You can do this by going into Start > Cont rol Panel > User Accounts.  In Vista, 
there will be a link to “Turn user account control on or off”.  Uncheck it, click OK all the 
way out and reboot the PC.  In Windows 7, there wil l be a link to “Change User Account 
Control Settings”.  Click that and then slide the s lider all the way to the bottom or “Never 
Notify”.  Click OK all the way out and reboot the P C.   
 
Please note also that some software firewalls can c ause problems for Neoterra Software 
in certain configurations.  This includes the windo ws firewall and Trend Micro products.  
If filtering any trusted networks, make sure to eit her turn off the firewall for the trusted 
side of the network, or allow exceptions to allow t rusted traffic in and out. 

CAUTION! 
The purchased ��� ������ �  application is governed by a licence agreement that INCLUDES 
a USB license dongle, that compounds the security of the application for your exclusive use. 
This USB device is a Serialized Key that handshakes with your ��� ������ �  application to 
validate its licensing parameters and contains information that verifies these parameters which 
relates to the features purchased.  This USB “key” MUST be inserted into a usable USB port on 
the Computer and left in place at all times, while the purchased application is in use.  Failure to 
do so or removal of the key at any time will result in the termination of the ��� ������ �  

application.  It is IMPERATIVE that the USB Secure Key be protected and secured at all times. 
In the event of loss or damage a replacement key can ONLY be purchased from NeoTerra ® 

Systems . 
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NeoTerra ® Systems  Contact information:  
 
NeoTerra ® Systems Inc:  
48 Centennial Road 
Unit #7 
Orangeville, Ontario. 
Canada. 
L9W3T4 
 
support@neoterra.ca                                                                                                                              
sales@neoterra.ca 
 
Business Number: +1-519-940-0088  
Facsimile Number: +1-519-940-8813 
 
(Please use the process within your Country to allow for direct dialling.) 
For your convenience you may wish to try: http://www.countrycallingcodes.com/ 
 
For more information on NeoTerra ® Systems  please visit: www.neoterra.ca 

Installing ��� ������ �  Enterprise Server: 

Minimum requirements: 
A Microsoft Windows Platform – Windows XP Professional, Windows Vista 
Professional/Business/Ultimate, Windows 7 Professional/Business/Ultimate, or Windows Server 
2008. neoConneX�  will run on both 32-bit and 64-bit operating systems. Please note that the 
software component for conventional and capacity plus MotoTRBO systems, neoNytro Node, 
will not operate on any Windows Server operating system. 
 

·  >= 2 GHz Quad-Core CPU  
·  At least 4GB of system memory (RAM) 
·  160 GB hard drive with at least 15 GB of available space (Minimum) 
·  Audio Output 
·  Local Area Network with IP Platform support 
·  Internet access for remote support  
·  Internet Domain (if hosting our web-based AVL, mailservice, or MultiSpeak web service) 
·  Internet Explorer 8+, Opera 10+, or Firefox 3.x+ web browser (for reporting and/or AVL 

Web solution). 
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The installation disc contains files that will be used for the successful installation of 
��� ������ � .  These folders & files are located under the “Server” folder”.  Follow the 
installation order below. 

 
1) setup.exe  – contains the full installation package and should be used for all FIRST time 

��� ������ �  installations.  neoConneX®  Server Setup.msi  is the file to use for 
UPGRADES to neoConneX.  These files are found under the “Server” folder.   

2) In addition: the ��� ������ �  Server Icons.exe  installs the icon files. Found under the 
“Server” folder. 

3) SQLEXPRWT_x64_ENU.exe or SQLEXPRWT_x86_ENU.exe  – The installation 
package for SQL Server Express (which is the free edition of the Microsoft SQL server 
database).  See Appendix C for information on the installation of SQL Server Express. 

4) Run neoConneX® Server  - and point it to the SQL server instance & data path in the 
system tab (see pgs 12-13 for more details).  Save & Exit, then re-enter the 
neoConneX® Server. 

 
For “purchased” applications, please install the US B Secure Key in a free USB 2.0, or 
higher, port. Please note that this port will be PE RMANENTLY occupied by the USB 
Secure Key for as long as the purchased ��� ������ �  application resides in the 
computer in question. See sample:>  
 
 

1. Start your computer and wait for the operating system to finish loading. 
2. Insert the ��� ������ �  CD/DVD, label-side up, into the appropriate CD/DVD-ROM 

drive on your computer. 

 
 
NOTE: If the CD-ROM has a spindle, make sure the CD is pushed all the way down. 
You should hear a “click”. 

If the disc does not “Auto” launch please follow this path below: 

1. Click on “Start” on the “Taskbar”. Look for the icon similar to – see below: 
a.           Windows XP 

 

b.          Windows Vista or Windows 7 

Security Key  (May not be exactly as shown) 
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2. One of the menu choices should be “Run” see below: 

 

 

3. Click on “Run”. A new window appears. 

 

 

 

4. Click on “Browse” 
5. When the “File Manager” or “Windows Explorer” window opens, go to the drive 

where the ��� ������ �  disc has been inserted and click on “setup.exe” or 
“setup”. 

 

6. You will now see the following: 

  

 

 

7. Click “OK” 
8. ��� ������ �  will now start to install. 

(Note: If you have a purchased, licensed copy of ��� ������ �  MAKE SURE 
THE SECURE KEY has been inserted into a spare USB p ort on your Computer 
to activate the license.)  

9. Follow the instructions. Once the installation is done ��� ������ �  will place a 
short cut icon on your “Desktop”.  

10. Then, proceed to repeat steps 2 through 9 for each installation file labelled 2, 3, 4 
as on the previous page of this manual.  File #4 (SQL Server) installation is 
described in the “SQL Server Installation” section below.  You MUST install SQL 
Server before running neoConneXAdm Setup.exe!! 

11. You are now ready to Configure your Radio Network prior to Setting up your  
��� ������ �  Enterprise Server System Application. 

Windows XP  
Windows Vista

Windows XP Windows Vista

Windows XP  Windows Vista 
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The MOTOTRBO™ Professional Digital Two-Way Radio System: 
 
Some interesting “points” to remember about the MOTOTRBO™ Professional 
Digital Two-Way Radio  
 
The Mobile radio has 5 terminal inputs and the Portable unit has 3 terminal 
inputs for use in telemetry. 
 
NeoTerra ® Systems  has taken advantage of these terminals to accommodate various tasks 
that are efficiently controlled by the ��� ������ �  application. 
 

Some value added inclusions within ��� ������ � : 
 
��� ������ �  has some embedded assistance within the application: 

1. Bundled geoMap maker for calibrating raster images for use in the GIS control. 
2. Web-based archive reporting tool. 
3. Bundled drivers in Quick start, which includes Motorola drivers using Ethernet over 

USB. 
4. Ability to integrate Conventional, Capacity Plus, and Connect Plus systems 

together. 
5. Mail service to negate the need to have a catch-all account or email aliases set up. 
6. Mappoint GeoCoding service to make ��� ������ �� more robust. 

 
 
 
There are 4 Protocols that ��� ������ �  uses with MOTOTRBO™ devices: 

1. Text Messaging – Can isolate a unit and send a unit-specific message to the 
device in question. 

2. ARS (Automatic Registration Service) – Advises of devices that come on- line and 
go off-line. 

3. Telemetry options – Sending automatic Text Messages that are based on actions 
taken by various operations at the remote location or vehicle. 

4. GPS Tracking – Location based Services. 
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SECTION 2 – Setup Guide 
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System Setup: 
 
Now that you have configured your radio network it’s time to set up the ��� ������ �  

application. 
 

On your computer “Desktop” locate the short cut ��� ������ �  icon:>  
Double-click the icon to launch the ��� ������ �  server application. 
 
The following screen will open: 

            Place your mouse over the “Setup” menu 
in the “Main menu” and click to open the 
“Setup” window. 

 

  
 
The following window will launch: 
The default System Password is 
LOWER case “pw”. 
Click “OK”. 
 

Log in window 
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On successful completion, go through each TAB in the SETUP window and configure the 
required parameters. 
 
The following tabs are available: 
 

1. System 5. Units 9. Admin Client 
2. Controller 6. Groups   
3. Customer 7. Email1   
4. Clients 8. Email2   

 
Note:   Before starting ����������� Server setup, make sure that you install SQL 
Server Express 2008 as in Appendix C of this user g uide.  That step is essential for being 
able to see all of the necessary tabs in the setup form  

The “System” Tab Setup: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The “Administration TAB” contains 2 main Sections: 
 

1. Licensing 
 
2. General Options 

 



��� ������ �  Server v4.0 - by  NeoTerra ® Systems 
 

Filename: neoConneX_Server_Training_ManualV4.doc  - Revised Date: 12/22/11 Page 13 of 55 
 

48 Centennial Road., Unit #7 Orangeville, Ontario. L9W3T4 
Tel: 1-519-940-0088 / Fax: 1-519-940-8813 – Email: sales@neoterra.ca 

www.neoterra.ca 

 
1. Licensing:  

 
License Serial Code  - Unique serial number of the USB license dongle (if installed on  
the Computer). 
 
Max Mobiles  – The maximum number of mobiles that the server is licensed to allow to  
connect. 

 
2. General Options:  

 
a. System Password  - Sets the password to access the System Setup area of 

��� ������ �    As indicated above, the “default” system password is “pw”. 
 

b. Network Interface – The network card on the PC to bind the ��� ������ �  server to 
(local LAN). 

 
c. IP Port – The TCP port on which clients connect to the server via the Network Interface. 

  
d. Store Aging – This is the maximum time that messages that have not been sent will be 

kept  in the message store (inbox). 
 

e. GPS Aging – This is the maximum time that GPS positions will be allowed to stay on a 
map in the neoConneX® client or in the neoConneX® web AVL solution. 

  
f. Retry Cycle  – The # of seconds it takes for unsuccessfully sent messages to get re-

sent. 
 

g. Server ID  – Reserved for future use. Please set to 65535 and do not use this radio Id 
anywhere else. 

 
h. Age GPS – Specifies that GPS positions will age. 

 
i. Delete GPS Offline – Allows the deletion of positions on the map when a unit goes into 

the Offline status. 
  

j. Use Emergency  – Enables/Disables use of the emergency capabilities of motoTRBO. 
 

k. Temporary Logging – This enables the creation of text file logs for debugging purposes 
(found in the %programData%\NeoTerra Systems\neoConneX Server\Logs folder). 

 
l. SQL Server –  This is a drop-down list of detected SQL server instances that are 

installed on the local machine.  The SQL browser service must be started on any given 
machine on the network that you want to specify as the SQL Server for ��� ������ , 
otherwise, it will not be populated in this drop-down.  Click the “Choose ++>” button to 
select the SQL server instance on which ����������� is installed. 

 
m. Data Path –  This specifies the path to the SQL server database files.  This provides an 

opportunity to specify a non-standard SQL Server data file location. 
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The “Controllers” Tab Setup: 
 
This screen defines the remote Connect+ controller addresses and ports. 
 
Note:  If controllers are set to point to each othe r controllers IP addresses, then they are 
considered to be ONE multi-site network. 
 

 
 
 
1. Network Settings:  
 

a. Name – The name to give the controller. 
 

b. Controller IP – The IP of the remote controller to connect to�  
 

c. Dialog ID – Unique ID for accessing the Connect Plus controller, must be unique for 
each entry. 

 
d. Watcher Range – The range of subscriber unit IDs to be monitored by this instance of 

����������� Server, it is wise not to duplicate radio ID across controller networks. 
 

e. PN Port  - The port assignment for Telemetry messages. You must configure the 
controller in question to match this port. Default: 4005 

 
f. TMS Port  - The port assignment for Text Message Service messages. You must 

configure the controller in question to match this port. Default: 4007 
 

g. LBS Port  - The port assignment for Location Based Service messages. You must 
configure the controller in question to match this port. Default: 4001 
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 The Radios Tab: 
 

 
 
Voice Interface –  This will be where the radio IP address will go for the voice channel  
 
Revert Interface  – This will be where the radio IP address will go for the GPS revert channel 
 
System Type – Two types: “Conventional” and “Trunking” 
 
Sprite Type –  Two types: “Hardware” and “Firmware” 
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How to edit setup screens with tabular data. 
 
This page shows how to edit and save data on setup screens where tabular data exists.  The 
method of modification is the same in every screen with tabular data. 
  
 
 

 
 
 
 

 

 

 
 
 
 
ADDING DATA: 

�  Click the “ADD” Tab to add some data to the tab in question 
�  Enter the details 
�  Click the ADD button again to save. 

 
EDITING or DELETING: 
Editing and deleting data is accomplished in very much the same way as Adding it.  To start an edit or 
delete, click on “Edit/Delete” Tab, then; by double-clicking on the row header (gray area next to the left 
most table column), the data will then appear in the edit controls for modification or, if the user wishes for 
deletion.  To save any changes when editing, click the “EDIT” button again.  To delete the record 
permanently, click the “DELETE” button. 

 

 Area to Double -Click  
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The “Customers” Tab Setup: 
 
This screen defines the customers that are able to login to this server.  At least one customer 
must be set up to continue on to the other tabs.  Adding more than one customer is only 
effective in hosted (web) mode. 
 
 
 
 

 
 
 
 

 

 

 

 
 
 
 
 
CUSTOMERS Tab Settings: 
 

�  Customer  – Give the customer a name – usually the name of the company you are installing 
neoConneX®  for. 

�  Cadence Count  – This is the number of high interval reports before reset to default reporting 
occurs. 

�  Cadence Interval  – This is the settings for temporary high GPS reporting interval. 
�  Emergency Email  – Any emergency or lone worker alarms that fire in ��� ������ �  will be sent 

to this email address. 
�  Web Map Type  (Obsolete) – 4 Choices: ESRI, Google, Yahoo, or Virtual Earth.  The latter three 

choices require sign-up for a unique key which is tied to the computer domain the PC running 
��� ������ �   is on (Virtual Earth does NOT require a key). 

�  Speed Threshold  – Specifies the speed at which the speeding alarm will be raised in the clients. 
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The “Clients” Tab Setup: 
 
This screen defines the users that are able to login to the server. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
CLIENT Tab Settings: 
 

�  Dispatch ID – This is the ID to give to one particular client that is to login to ��� ������ �  

Server.  This must be unique across all tabs that ask for ID’s (Eg: Unit ID, Group ID). 
�  Client Name  – The friendly name to associate with the ID.  This is also the login name when the 

client logs in to the ��� ������ �  server. 
�  Customer Name  – This setting defaults to the very first customer defined in the customers tab if 

in any other mode than “hosted”.  If in hosted mode, the dropdown list of customers at the top of 
the setup screen can be set to another customer, assuming there are additional customers set up 
of course. 

�  Client Password  – This is the password that the client will use when logging into the 
��� ������ �  server. 

�  Windows Client – This enables/disables the ability for a client to use the ��� ������ �  client 
for a given client login. 

�  Text Enabled – This setting allows enabling/disabling text messaging capability on 
����������� clients. 

�  GPS Enabled – This setting allows enabling/disabling of GPS capabilities on �����������
clients. 

�  Web Client – This enables/disables the ability to use the AVL web solution for a given client 
login. 

�  Mobile Client – This enables/disables the ability to use any of the mobile AVL solutions for a 
given client login. 

�  Reports Client – This enables/disables the ability to use the web based reporting for a given 
client login. 
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The “Units” Tab Setup: 
 
This screen defines the valid units that are able to send/receive digital data in ��� ������ �  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
UNIT Tab Settings: 
 

�  Unit ID  – This ID must match up with a Radio ID out in the field. 
�  Unit Name  – The friendly name to associate with the Unit ID.  Once added to the database, this 

field cannot be changed (unless deleted and re-added) 
�  Polling Interval  – This tells ��� ������ �  how often to poll the GPS for this unit and update its 

position. 
�  Group  – This assigns a group from A to F for the unit for partitioning off of groups of units. 
�  GIS Symbol  – This is the icon that will be associated with the unit when being displayed on GIS 

(raster) maps as well as internet based maps (Google, Yahoo, Virtual Earth). 
�  MapPoint Symbol  – The icon to associated with the unit when being displayed in Microsoft 

MapPoint. 
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The “Groups” Tab Setup: 
 
This screen defines the Groups that exist in the MOTOTRBO radios. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
GROUP Tab Settings: 
 

�  Group ID  – The Unique Group ID to assign to the Group.  This should match any Group ID’s set 
in the radios. 

�  Group Name  – This is the friendly name to associate with the Group ID.  Once set, this field 
cannot be altered.  The only way to alter the group name is to delete and re-add it. 

�  Group – This assigns the group to a particular partition.  In this way, the user can segregate 
groups of units in cases where there are multiple dispatchers that only want to see certain 
group(s) on their map. 
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The “Email1” Tab Setup: 
 
This screen defines the email account settings that enable ��� ������ �  to bridge radios and 
the internet.  

 
 

 

 

 

 

 

 

 

 
General  
 
Dispatch ID –  The number used to give the email a unique dispatch ID. 
 
Email - This is the address used to send email from a radio or to receive an email for delivery to a radio. 
 
Customer Name  – Indicates the customer that this email translation is tied to. 
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The “Email2” Tab Setup: 
 
This screen defines the users that are able to send/receive email through ��� ������ �  to any 
radios on the system.  If the email address is not listed in this screen, then any messages sent 
by that email address will be unceremoniously dumped and treated as spam. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
General  
 

�  System Domain  – This is the domain of the mail server that will be used when generating emails 
from out of ��� ������ . Please point this domain’s MX record to this server’s IP address. 

 
�  Mail Service Address  – This is the address that the mail service that handles the outgoing and 

incoming mail to/from ��� ������ . If you are running the NeoTerra mailService set this to 
127.0.0.1. 

 
�  Mail Service Port  – This is the port of the mail service that handles the outgoing and incoming 

mail to/from ��� ������ . If you are running the NeoTerra mailService set this to 41000. 
 
SMTP 
 

�  Server – The name of the SMTP server used to send mail out of the system to the internet. 
 

�  Port – The port of the SMTP server used to send mail out of the system to the internet. 
 

�  Username – The username for the SMTP account used to send mail out to the internet. 
 

�  Password – The password for the SMTP account used to send mail out to the internet.  
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The “Admin Clients” Tab Setup: 
 
This screen allows the neoConneX® server administrator to define users who will be allowed to 
use the new neoConneX® web-based administration tool.  This tool allows others to 
administrate neoConneX® data connected to customers (Customers, Clients, Units, Groups and 
Emails). 
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Save and EXIT: 
On completion of the System Set up click on “Save and Exit” in the top left hand corner of the 
“Setup” window to ensure all your data and changes that were recorded have been secured and 
saved.   
 
Save and Exit does NOT save  settings on tabs that have an Edit/Delete tab or a grid of data 
displayed on them (such as Customer or clients).  So, for example, to save a change to an 
existing customer, you must click the “Edit” button again to save it.  To add a new customer, you 
would click on the “Add” button.  See the page titled: “How to edit setup screens with tabular 
data” for more details. 
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SECTION 3 – Using ��� ������ �
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Server Screen:  
�
 

 

This is your main screen when neoConneX starts up. In this screen it shows what you have 
setup in the configuration, what is active in the server & your licence key with expiration.  
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Presence Screen: 
 
This screen shows the status of all connected units (to the ��� ������ �  PC) 
 
UnitID – The radio ID of the unit. 
 
Presence – Shows as Online, OFFLINE, EXPIRED, or Unknown.  This is equivalent to the ARS 
registration status from neoNytro. 
 
PN Date/Time – The date & time the last presence notifier status was received for the unit. 
 
TMS Service – Displays whether the Text Messaging is Online or OFFLINE. This should be 
online if you are using the text messaging service on the MotoTrbo Radios. 
 
LRRP Service – Displays whether the Location Request Routing Protocol is Online or 
OFFLINE. This should be online if you are using GPS service on the MotoTrbo Radios and 
neoConneX � . 
 
LRRP Date/Time – The date & time of the last time an LRRP service status was received from 
the unit. 
 
 
Filter Checkbox – Check this to filter the list of displayed units by Customer. 
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Interfaces Screen: 
 
This screen shows any of the 6 interfaces defined in the “Controllers” tab under in the setup 
form.   If an interface is online, the PN Server bar will turn from red to green and display the IP 
address of the controller it is connected and listening to.  The traffic queues show in real-time 
what types of traffic are coming in to and going out of the controller.  To reboot the connection to 
a controller, one simply needs to click on the “Reset” button. 
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Radios Screen: 
 
This is a new feature that allows the user to plug in base stations into neoConneX server for IP 
Site Connected, & Capacity Plus. The below screen shows which radios are plugged in. 
 

 
 
 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 

Traffic Screen: 
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This screen displays any traffic that ��� ������ �  is handling, connection activity, as well as 
any client and nytroNode connections. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



��� ������ �  Server v4.0 - by  NeoTerra ® Systems 
 

Filename: neoConneX_Server_Training_ManualV4.doc  - Revised Date: 12/22/11 Page 31 of 55 
 

48 Centennial Road., Unit #7 Orangeville, Ontario. L9W3T4 
Tel: 1-519-940-0088 / Fax: 1-519-940-8813 – Email: sales@neoterra.ca 

www.neoterra.ca 

Filtered Controller Traffic: 

 

 

 

 
 

 

 

 

 

 

There is a new feature that allows the user to view Filtered Controller Traffic. Filtered Controller 
Traffic gives the user an option in which Customer Traffic they would like to view 
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Messages Screen: 
 
This screen shows any email messages that are queued up in either the incoming or outgoing 
directions from the ��� ������ �  server.  
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Mobile Screen: 
 
This screen shows any mobile messages that are being received and sent by the 
��� ������ �  server. The Mobile Server allows ��� ������ �  to receive commands and 
send data to and from the neoConneX® Mobile Clients. Reserved for use with Blackberry and 
Android cellular devices.  
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SNPP Screen: 
 
This screen shows any SNPP (Simple Network Paging Protocol) messages that are being 
received by the ��� ������ �  server.   The SNPP server allows ��� ������ �  to receive 
pages from a pager over the network. 
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SECTION 4 – Using the  

����������� Provisioning Tool 
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About the neoConneX® Provisioning Tool 
 
The tool was developed as a way to allow others to remotely administrate the addition, 
modification, and deletion of users in the neoConneX® server application without the need to 
have full admin rights or remote access to the neoConneX® Server PC itself.  The overall look 
and feel of the administration tool has been kept the same as the neoConneX® Server to allow 
for a consistent user experience. 
 

Login Screen  
 
You need a login and password to gain access to the neoConneX® Admin tool.  These users 
are set up by the neoConneX® server administrator under the “Admin Clients” tab (See the 
page titled: “The “Admin Clients” Tab Setup” for more details). 
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Customers Tab  
 
This tab allows the addition, modification, or deletion of a customer.  Changing the “Customers” 
dropdown list at the top of the form has no effect on entries in this table since this is the root 
(master) of all other tables in this application. 
 

 
 
 
Note: If you cannot see the above tab contents afte r logging in with Internet Explorer 8, 
then click “Tools” > Click “Compatibility View Sett ings” > UNCHECK “Display intranet 
sites in Compatibility View”.  Both Internet Explor er 8 and Opera 11+ give the best user 
experience when using this application. 
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Clients Tab  
 
This tab allows the addition, modification, or deletion of a neoConneX® Client.  Changing the 
Customer dropdown at the top of the form will allow changing the customer to which the email 
belongs. 
 
Choose the record action “Add” to create a new record, or “Edit” to modify or delete an existing 
record. 
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Groups Tab  
 
This tab allows the addition, modification, or deletion of a group. Changing the Customer 
dropdown at the top of the form will allow changing the customer to which the group belongs. 
 
Choose the record action “Add” to create a new record, or “Edit” to modify or delete an existing 
record. 
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Units Tab  
 
This tab allows the addition, modification, or deletion of a unit.  Changing the Customer 
dropdown at the top of the form will allow changing the customer to which the email belongs. 
 
Choose the record action “Add” to create a new record, or “Edit” to modify or delete an existing 
record. 
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Email Tab  
 
This tab allows the addition, modification, or deletion of an email address. Entries in this tab 
correspond to the Email1 tab in the neoConneX® Server. Changing the Customer dropdown at 
the top of the form will allow changing the customer to which the email belongs. 
 
Choose the record action “Add” to create a new record, or “Edit” to modify or delete an existing 
record. 
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Appendix A  
How to set up the geoCoder for use with ��� ������ �  
 
In order to setup reverse-geocoding for use with neoConneX, you must first install the 
neoConneX® Server application and Microsoft MapPoint.  The neoConneX® Server installation 
can be found under the “Server” folder on the installation CD.   Microsoft MapPoint is found in 
the Microsoft MapPoint box accompanying the neoConneX® Server package.  To configure the 
geoCoder service, look under:  Start > Programs > NeoTerra Systems > neoConneX > Server > 
Utilities > geoCoder Configuration 
 
Windows XP: 
 

 
 
Windows Vista and 7: 
 

 
 
Reverse geoCoder: 
 

You have the choice between OSM and MapQuest 
reverse geocoding. Open Street Maps is limited to 1 
reverse geocode per second while MapQuest is 
limited to 2 per second. If you are having issues with 
the geocoder it is advised that you try switching 
chosen provider. Your source selection is saved. 
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Appendix B  
How to set up email for use with ��� ������ �  
 
In order to setup email for use with neoConneX, you must first install the neoConneX® Mail 
Service.  This installation can be found under the “Mail Service” folder on the installation CD.  
To configure the mail service, look under:  Start > Programs > NeoTerra Systems > 
neoConneX® > Server > Utilities > Mail Configuration. 
 
 

 
 



��� ������ �  Server v4.0 - by  NeoTerra ® Systems 
 

Filename: neoConneX_Server_Training_ManualV4.doc  - Revised Date: 12/22/11 Page 44 of 55 
 

48 Centennial Road., Unit #7 Orangeville, Ontario. L9W3T4 
Tel: 1-519-940-0088 / Fax: 1-519-940-8813 – Email: sales@neoterra.ca 

www.neoterra.ca 

Appendix C  
How to set up SQL Server for use with ��� ������ �  
 
����������� uses the SQL Express 2008 database as its back-end storage mechanism.  The 
following pages detail how to install and set up SQL Server for use with �� ������� . 
 
Click on Planning and then System Configuration Checker to check if any prerequisites need to 
be installed prior to installing SQL Server Express. 
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The System Configuration Checker will output a screen as below indicating any problems.  If 
there are any, you can go to www.microsoft.com, click the “Downloads” menu link at the top of 
the page, and then enter the name of the missing element in the download page search bar.  Be 
sure to pay attention as to whether you will need a 32-bit version of the missing component or a 
64-bit one (depends on your Operating System). 
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Choose to install a new SQL Server instance. 
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Click next, “I Agree”, next. 
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Click “Next” and then check off all features, Next. 
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Give the SQL Server an instance name if one is not already populated (SQLEXPRESS is the 
default if no other SQL Server instance is installed on the PC). 
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Specify “System” as the account name for the database engine service.    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Make sure that we’re using Mixed authentication mode.  Click the “Add Current User” button 
and also click the “Add” button, adding the “Administrators” group to the list of SQL Server 
Administrators.  Click “Next” when done.   
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Click “Next” through the next few screens. 
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Review the installation items and then click “Install” to begin installation of SQL Server. 
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Installation is now complete. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Now you need to turn on the SQL Server Browser so that during the neoConneX® Server setup, 
the list of SQL servers will be populated in the dropdown box that specifies the server and 
instance name that is running ��� ������ .  To do this, go into Start > Control Panel > 
Administrative Tools > Services, and find the “SQL Server Browser” service.  Right-Click on it 
and click “Start”. 
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The other item that you must take care of is to enable the TCP/IP stack for the protocols in the 
instance of SQL Server Express that was just installed (pay attention to the instance name if 
multiple instances of SQL Server are loaded). 
 
Click on TCP/IP, right-click, then click “Enable”. 
 
After SQL Server is installed, you can launch neoConneX® Server and neoConneX® will 
automatically copy over the necessary SQL databases to the location they are needed in.  If it 
does not, check the following: 
 

·  Make sure that you have specified the correct SQL Server instance in the system Setup 
tab of neoConneX® Server. 

·  Check that TCP/IP is enabled in the SQL Server Configuration Manager (seen below). 
·  Make sure that User Account Control is turned off 

 

 
 
After running through step #5 on page 7 to point the neoConneX® server to the database 
instance name and the physical data path to the SQL Server database files (see pgs 12-13 for 
more details on how to do this), perform the following: 
 

·  Open SQL Server management studio (Start > Programs > Microsoft SQL Server 2008 > 
SQL Server Management Studio 

·  Select File > Open > Select the Perm.Sql file in the C:\Inetpub\wwwroot\neoConneXAdm 
folder. 

·  Click the Execute button on the toolbar (It should report Command Completed 
Successfully). 

·  Close SQL Server Management Studio 
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Notes: 
 
 


